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While most presentations that you deliver will be presented  
on-screen or electronically, you may still need to print your 
slides. For example, it’s always a good idea to print your 
slides before presenting them so that you can proofread 
the text. Or, you may want to provide handouts to the 
audience or print your speaker notes.   

A presentation can be printed in a variety of ways: as 
slides, handouts, notes pages and as an outline. 

In this booklet we will show you how to: 

 gain an understanding of printing 

 preview slides 

 print slides 

 print handouts 

 print notes pages 

 print the presentation outline. 

INFOCUS 
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Printing, in its simplest form, means 
producing a paper copy of a document that 
you have created on the computer. Early 
forms of printing required typesetting, 

printing presses and ink. These days 

printing only requires a printer that converts 
the electronic form of the document into 
letters and other graphics on a page. Before 
you commit a presentation to paper, 

consider the following points. 

Resisting The Urge To Print 

These days printers are very cheap, easy to install and easy to use. While computers 
were supposed to reduce the amount of paper that we used and introduce a paperless 

age, in reality they have made it easier to go through pages and pages of paper while 
we review and modify documents. If you take some time to think about the following, 
you may well reduce the volume of paper that you use. 

Draft Versus Final 

The first thing to consider is why you are printing. If you just want to review the layout 
and proof the text, there is a good case for printing only a draft copy of the 

presentation. This uses less ink and in some cases, prints more quickly than a best-
quality copy. If you have a colour printer, then you can often choose to print in 
greyscale or black and white, saving the more expensive colour ink for later. If it’s 
the final copy that you want to print, then you should make sure you’ve previewed the 
output so that you don’t waste precious ink, time, paper and patience. 

When Printing Isn’t Printing 

Traditionally, printing referred to creating a hard copy of a document, meaning a copy 
of the document on paper. These days printing can also be used to create an electronic 
version of the document, known as a soft copy. For example, you can print to the 
Microsoft XPS Document Writer and create an XPS version of the file. You can also print 
to a file and create a .PRN file which is used for printing.  

Printer Type 

One of the first things you should do before printing a presentation is to select the 
printer that you intend to use. This is partly because functionality may vary between 
printers. For example, printers designed to print photographs can print right to the edge 
of the page (borderless printing) whereas other printers, such as most lasers, have a 
non-printable area around the edge of the page. There are many types of printers you 
may have access to, such as colour printers versus black and white and laser printers 
as opposed to inkjet. As a rule, colour printing is more expensive than black and white 
and laser printing is more expensive, but better quality, than ink jet. 

Default Printer 

The default printer is the printer that appears under Printer when you click on the File 
tab and select Print. It’s the printer that will be used unless you select a different one. 

Previewing Before You Print 

When you select Print in the Backstage, a preview of how the presentation will look 
when it’s printed will appear in the right half of the view. You should always check the 
preview of a presentation in the Backstage before sending it to a printer. 
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Try This Yourself: 
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Before starting this 
exercise you MUST open 

the file P818 
Printing_1.pptx... 

1 Click on the File tab to 
open the Backstage, then 
click on Print 

The first page of the 
document will appear 
showing how it will print 
on the right side of the 
Backstage window... 

2 Click on Next Page  at 

the bottom of the preview 
pane to preview each slide 
in the presentation 

3 Click on Previous Page 
 until you return to slide 

1 

4 Click on Print All Slides 
under Settings and select 
Print Current Slide to 
apply this setting  

Now only this slide will 
print… 

5 Click on Colour and select 
Pure Black and White 

This setting is useful when 
printing draft copies of 

your slides… 

6 Click on the Home tab to 
return to the presentation 

 

For Your Reference… 

To preview a presentation: 
1. Click on the File tab 
2. Click on Print 
3. Click on Next Page  to preview each 

slide 

Handy to Know… 

 If you want to print a draft copy of 
your presentation, say for proofreading 
purposes, opt to print the presentation 
as handouts with multiples slides per 
page (under Settings) as well as in 

black and white. This will save paper 
and printer resources, such as colour 

ink. 

1 

5 

Before printing your slides, it’s always a 
good idea to preview how they will appear 
when printed. You can preview your 
presentation in the Print area of the 

Backstage. What you see in the Backstage 
will depend on the printing settings that you 
have applied, and what you see is what you 
will get when you print the presentation. 
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PRINTING SLIDES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file P818 
Printing_1.pptx... 

1 Press  +  

This handy keyboard shortcut 
will open the Print area of the 
Backstage. 

Let’s print several slides… 

2 Ensure the desired printer is 
selected under Printer 

3 Click in Slides and type 1,3-
5 

This range will print four 
slides – 1, 3, 4 and 5. Notice 
that Custom Range displays 
automatically in the field 
above… 

4 Click on Full Page Slides in 
the next field (ensure Full 
Page Slides remains 
selected), then click on 
Frame Slides 

The slides will now print with 
a border… 

5 Click on Full Page Slides 
again and click on Scale to 
Fit Paper 

The slides will increase a little 
to fit the printer page size… 

6 Click on [Print] to print the 
four slides or press  to 

save paper 

 

For Your Reference… 

To print slides: 
1. Press  +  

2. Select specific slides in Slides if 
desired 

3. Select Full Page Slides under 

Settings 
4. Set other options as desired 

5. Click on [Print] 

Handy to Know… 

 If you set specific options in the print 
area of the Backstage, they will still 
be selected when you visit this view 
again during the same session. So if 
you press  +  and press , you 

will print using the last settings. The 
options will reset to the default values 

when you close down PowerPoint. 

3 

5 

Like most Office applications, Microsoft has 
combined the printing and print preview 
features into the one area of the 
Backstage in PowerPoint. This makes it 

easy to print exactly what you want. To 

print your presentation as a series of slides, 
you will need to select Full Page Slides 
under Print Layout in the third field 
beneath Settings plus other options as 

required. 
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PRINTING HANDOUTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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 Continue using the 

previous file with this 
exercise, or open the 
file P818 
Printing_1.pptx... 

1 Press  +  to open 

the Print area of the 
Backstage 

The settings that you 
selected in the last 
exercise will still be set 
so you must check 
them all… 

2 Click on Custom 
Range and select 

Print All Slides 

3 Click on Full Page 
Slides and select 3 
Slides under 
Handouts 

The preview shows 
that each handout will 
have three slides with 
lines for note taking. 
The two settings 
Frame Slides and 
Scale to Fit Paper are 
still selected from the 
last exercise... 

4 Click on [Print] to 
print the four 
handouts or press  

to save paper 

 

For Your Reference… 

To print handouts: 
1. Press  +  

2. Select the desired layout under 
Handouts in the 3rd field beneath 
Settings 

3. Set other options as desired 
4. Click on [Print] 

Handy to Know… 

 With the 4, 6 and 9 slides handout 
layouts, you can choose whether the 
slides are presented vertically or 
horizontally. Selecting one of the 
horizontal layouts is probably the most 

appropriate as we read pages from left 
to right. 

One of the most frequently used print 
layouts is the handout with 3 slides per 

page. This is ideal as a working document 
for the audience. Not only does it print all 

of your slides, but it also provides a ruled 

area for the audience to write notes. If you 
have lots of slides that you don’t believe will 
require note taking, you could opt for the 9 
slides per page layout to keep printing costs 

down. 

3 
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Try This Yourself: 
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 Continue using the 

previous file with this 
exercise, or open the 
file P818 
Printing_1.pptx... 

1 Press  +  to open 

the Print area of the 
Backstage 

2 Click on Print All 
Slides and select 
Print Current Slide 

Notes have been 
included in only the 
first slide... 

3 Click on 3 Slides and 
select Notes Pages 
under Print Layout 

The preview shows 
that the slide will print 
at the top of the page 
with the notes just 
below... 

4 Click on [Print] to 
print the page or press 

 to save paper 

 

For Your Reference… 

To print notes pages: 
1. Press  +  

2. Select Notes Pages in the 3rd field 
beneath Settings 

3. Set other options as desired 

4. Click on [Print] 

Handy to Know… 

 If you want to change the layout of the 
notes pages or handouts, such as adding 
a logo, you can change them using the 
Notes or Handout Masters. Click on Notes 

Master or Handout Master on the View 

tab. You can add graphics, change fonts 
and adjust margins to create exactly what 
you want. 

Notes pages are ideal as prompts for the 

speaker or for providing additional 
information to the audience. They also let 
the speaker take notes about any 

discussions that took place regarding 

specific slides. If the speaker adds these 
notes to the slides’ notes panes and then 
reprints the notes pages, they can serve as a 
record of the decisions made or ideas 

discussed. 

3 
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PRINTING THE OUTLINE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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 Continue using the 

previous file with this 
exercise, or open the 
file P818 
Printing_1.pptx... 

1 Press  +  to open 

the Print area of the 
Backstage 

2 Click on Print Current 
Slide and select Print 
All Slides 

Let’s print the text for 
the first two slides... 

3 Click on Notes Pages 
and select Outline 
under Print Layout 

The preview shows 
that the outline of the 
presentation will print 
on two pages... 

4 Click on [Print] to 
print the pages or 
press  to save 

paper 

 

For Your Reference… 

To print the outline: 
1. Press  +  

2. Select Outline in the 3rd field beneath 
Settings 

3. Set other options as desired 

4. Click on [Print] 

Handy to Know… 

 The Outline layout is based on the 
Handout Master. If you want to add a 

title or logo or change the format of the 
outline, click on Handout Master on 

the View tab and make the changes 

there. 

If you only need to print the text content 
of a presentation (not images of the 
slides), the Outline layout is ideal. The 

outline is useful for summarising your 

presentation – for example, for checking 

that you have included the required content 
and that it is in the correct order. You can 
also reduce printing costs by giving your 
audience the outline rather than handouts.  

3 
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CONCLUDING REMARKS 

 

 

 

 

Congratulations!  

You have now completed the Printing booklet.  This booklet was designed to get you to 
the point where you can competently perform a variety of operations as outlined in the task 
list on page 2. 

We have tried to build up your skills and knowledge by having you work through specific 
tasks. The step by step approach will serve as a reference for you when you need to repeat 
a task. 

 

Where To From Here… 

The following is a little advice about what to do next: 

 Spend some time playing with what you have learnt. You should reinforce the skills 
that you have acquired and use some of the application's commands. This will test 
just how much of the concepts and features have stuck! Don't try a big task just yet if 
you can avoid it - small is a good way to start. 

 Some aspects of the course may now be a little vague. Go over some of the points 
that you may be unclear about. Use the examples and exercises in these notes and 
have another go - these step-by-step notes were designed to help you in the 

classroom and in the work place! 

Here are a few techniques and strategies that we've found handy for learning more about 
technology: 

 visit CLD’s e-learning zone on the Intranet  

 read computer magazines - there are often useful articles about specific techniques 

 if you have the skills and facilities, browse the Internet, specifically the technical 

pages of the application that you have just learnt 

 take an interest in what your work colleagues have done and how they did it - we 
don't suggest that you plagiarise but you can certainly learn from the techniques of 
others 

 if your software came with a manual (which is rare nowadays) spend a bit of time 
each day reading a few pages. Then try the techniques out straight away - over a 
period of time you'll learn a lot this way 

 and of course, there are also more courses and booklets for you to work through 

 finally, don’t forget to contact CLD’s IT Training Helpdesk on 01243-752100 
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